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p.13,14Handy Functions - 
Creating high-quality posters 
using the design assistant 
function

PosterArtist Quick Guide

 Opening Manual
Click PosterArtist Manual in the 
lower left of the screen to open the 
manual.

 License Authentication
When starting PosterArtist for the first time after installation, the license authentication screen is 
displayed. Enter the correct license number. (License authentication will be required again when 
replacing your computer or hard disk.) 
For details, see the installation guide and manual.

Create posters in four easy steps

Simply select a poster type and a design 
image to automatically create high-quality 
posters.

Choose the best template for your needs from the 
complete set provided and add finishing touches to 
customize it. After a few easy enhancements, you'll 
have a poster that looks like your own, original work.

From this point, simply print your finished poster. 

You can also use powerful editing 
features to arrange the design.p.2
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Select the poster design you want from the following: Photos/Illustration 
Focus to emphasize photos, Keyword Focus to maximize the appearance 
of text, Sentence Focus for entering large amounts of text, and Long/
Horizontal Banners for horizontal or vertical banners.

Click Auto Design.2

Using Auto Design Function (1)

Click Select Template.1

Select the desired poster type in Poster Type and 
click Next.3

Select a design 
image for the poster.
Poster colors and fonts change 
depending on the design 
image. For example, select 
Spring for soft images and 
Casual for cheerful images.

4

Specify the text and 
paper orientation.5

Click From Photo 
Library.6

Select the desired 
photo and click OK.
To specify multiple photos at 
one time, click photos while 
holding down the Shift key or 
Ctrl key.

7

Automatically create multiple posters to choose from by specifying 
the poster design image, titles, photos, clipart, and other elements.
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Now follow the steps in Paper Options(p.5), Edit(p.6), and 
Print(p.12) after the next page.

Using Auto Design Function (2)

Click Next.
This starts auto design 
and displays multiple 
designs using the 
specified text and photos.

8

Select Color Patterns if you want to adjust 
the overall colors of the poster.9

Select the desired design.10

Click OK.11

The first photo is treated 
as the main photo. You 
can drag photos to 
change their order.

Dragging photos to 
change their order 
changes the position of 
photos in the poster.
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Click Select Template.1

Using Templates

Tip Managing Artwork
Materials including photos, clipart and templates for use in PosterArtist are 
collectively referred to as "artwork."

Tip Registering Templates
Register created posters in the library as templates using the Add to Templates 
function. Registered posters can be used in the same way as other templates.

To open saved posters, 
click Open Poster and 
select a file.

To open all provided 
templates, click View All 
Templates.

Select the category including the 
desired template.
Templates are listed.

2

Double-click the template.3

The selected template is displayed to the right 
enlarged.

Click  (Artwork Manager 
Dialog) to open the Artwork 
Manager dialog box. This dialog 
box allows you to organize 
artwork for easier use by adding 
categories, changing the display 
order, etc.

Choose a template and arrange elements to your liking to finish 
your poster.

Tip Download Contents Function
Use the Download Contents function to view a poster 
collection, download additional templates, and more on the 
Internet.
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When changing the poster 
orientation in Poster 
Orientation, the design 
layout may be affected.

Select a printer for 
printing posters.3

Tip Additional Paper Options

Matching the long side with roll 
paper width

Paper Options

● Borderless printing
To print posters without a border, place a checkmark for Borderless Printing. For 
information on supported paper, see the manual of your printer.

● Enlarged/reduced printing
To print posters in an enlarged/reduced scale according to the width of roll paper 
loaded in the printer, place a checkmark for Enlarged/Reduced Printing.

● Print direction
For borderless printing and enlarged/reduced printing, select Fit Long Side to Roll 
Width or Fit Short Side to Roll Width.
For example, when printing an A1 original in portrait orientation on A1 width paper, 
select Fit Short Side to Roll Width to print at A1 size.
Otherwise select Fit Long Side to Roll Width to print at A2 size.

● Media size
To print posters in the specified size, adjust settings here.
Media size may not be specified depending on the status of other settings. For 
details, see the manual.

Matching the short side with roll 
paper width

Print direction Print direction

Click Paper Options.1 Select a poster size.2
To specify the poster size 
freely, select Set Custom 
Size. (Available when Roll 
Paper is selected in Media 
Source.)

Note

Select a paper 
source, paper type 
and roll paper width.

4
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Editing (1) Substituting photos in the library Editing (2) Substituting your own photos

Click Photos in Edit.1 Click the photo you want 
to replace.
The photo is framed in orange.

2

Click the Photos tab.3
Select the category including the desired photo.4

Double-click the photo to 
substitute.
The photo selected in step 2 is replaced 
with the one selected from the library.

5

Click the photo you want to 
replace.1

Click Add/Replace.
The file selection screen is displayed.

2
Select the photo to 
substitute and click Open.3

Tip Adding Photos
To add a photo instead of replacing one, perform step 5 with no photo selected 
(with no artwork framed in orange). 
Alternatively, drag and drop a photo in the library to the poster.

Tip Moving, Resizing and Rotating Photos

Drag photos and clipart to move them freely. To resize them, drag  displayed 
on the vertices and sides of the orange frame.
To switch between the resize mode and rotate mode, click  or  displayed 
in the lower left of the frame.
In the rotate mode, drag  to rotate photos.

The photo selected in step 1 is replaced with the 
specified photo.
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Click  (Retouch Image).2
Click  (Color Adjustment).3

Click OK.6
Tip Slant Correction & Gradation

On this screen, slant of images can be corrected with  (Slant Correction).
Use the Gradation tab to specify transparency of the entire image or to apply 
gradation vertically, horizontally or diagonally.

Click  (Trim).2
Click the Trim tab then  (Trim).3

Editing (3) Trimming photos Editing (4) Correcting photos

Trimmed photo

Click the photo to correct colors.1

Drag to 
specify the 
area to trim.

4

Click the photo you want to trim.1

Click Close.5

Adjust the color tone using 
items in this area.4

Click OK.5
Tip Additional Image Correcting Functions

Besides color correction, these image correction options/effects are available.
• Auto Color Correction • Color Point Correction (Specifies white, gray and black points.)
• Backlight Correction • Sharpness • Soft Focus • Monochrome
• Sepia • Logo Color Adjustment (Adjusts specific colors.)  • Cut Out

After specifying the 
area, drag it or a 
vertex to adjust the 
position or size. 
Click  to restore 
the default aspect 
ratio.
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Drag  in the center of the right side to the right to 
adjust the frame width.
The text width is enlarged accordingly.

7

Tip Adding Text

To add text, click  and drag on the poster to specify the area, then enter text.

Double-click text that you want to edit.1
Editing (5) Changing text, font, font size and alignment

Click text that you want 
to edit.4

Change the font size.
The text size changes.6

Select a font.
The text font changes.

5

Change the text.2

Click outside the editing box.3

An editing box is displayed.
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Click  (Line).2Click Shapes in 
Edit.1

Editing (7) Drawing shapes (arrows)

Rectangles and circles can also be drawn.

Click Custom 
and select a color 
then click OK.

5

Change the line 
thickness.4

Drag from start point to end point.
A line is drawn.

3

Change the end 
point to arrow.6 Click a part other than the 

arrow to deselect it.7
Select  (Set Shaded Text) to apply a drop shadow to text.

Select   
(Fill and Stroke).2

Tip Applying a drop shadow

Editing (6) Decorating Text

Select text to apply 
effects to.1

Place a checkmark.3 Click Custom, select a 
color and click OK.4

Click OK.
The text is outlined.

6
Specify the width 
and shape of the 
outline.

Click Apply to check 
the appearance.
Outline settings are reflected 
in the text on the poster. 
(Continue changing settings 
and clicking Apply as 
needed.)

5
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Editing (8) Adding clipart

Tip Clipart Color
To change the clipart color, select a color in Clipart 
Color.

Click Clipart in Edit.1 Select the category 
including the desired 
clipart.

2

Double-click the 
clipart you want to 
add.
The clipart is added to the 
poster.

3 Drag the clipart to 
adjust the position 
and size.

4

Click Backgrounds in 
Edit.1

Editing (9) Changing the background

Select the category 
including the desired 
background.

2

Double-click the desired background.
The background is changed.

3

Select a background color.
The background color is changed.

4
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Click  (Align and Distribute Objects Dialog).3

Click  (Center Horizontally on Page).4

Click .5

● Ruler
Displays a ruler at the top and left of the poster. To 
display rulers, select Ruler in the View menu.

● Guide
Lines for alignment, etc. Use  on the toolbar to 
set or display them.

● Grid
Squares of the same size. To display them, click 

 on the toolbar.

Click an object.1

Tip Ruler, Guide & Grid
The ruler, guide and grid help you easily adjust the position and size of the object 
on the poster. Use the snap function of the guide and grid to align objects simply 
by dragging them.

Editing (10) Aligning multiple objects

Tip Align and Distribute Dialog Button
On the Align and Distribute Dialog screen, these functions are available.

Align objects at the left edge, center or right edge.

Align objects at the top, center or bottom.

Evenly space more than three objects horizontally or vertically.

Center objects horizontally or vertically on the page. 
Each object is resized to match the height or width of the object 
that was selected first.

While holding down 
the Shift or Ctrl 
key, click another 
object.
The two objects are selected.

2

The objects are centered.

Tip Grouping Objects
Group multiple objects to adjust the positions, sizes 
and rotation angles at one time as if handling them 
as a single object. 
For example, group a map, etc. that is made of many 
shapes for easier handling.
Click multiple objects while holding down the Shift 
key or Ctrl key then from the Object menu, select 
Group in Group.
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Select Print Quality.6
Printing — Saving and printing posters

In the File menu, select Save As.1

Specify the name and 
save location and click 
Save.
The poster is saved as a PosterArtist 
file with a ".cpfx" extension.

2

Select Print.3

Check the test print appearance.
Continue editing and test printing as needed.
Proceed when the test print is satisfying.

5

Click Test Print.
The poster is printed on small paper for 
checking.

4

Specify the print quantity.
Click ▲ or ▼ to specify the number of 
copies.

7

Click Print.8

Check the preview 
and print setting 
status, then click 
Print.
Printing starts.

9

Posters can be saved as JPEG files 
by selecting Save As JPEG in the File 
menu. However, these files cannot be 
edited with PosterArtist.

Specify the printer and 
paper size for Test Print 
from Preferences in the 
Edit menu.

On this screen, the printing 
image and status of print 
settings can be checked.
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Handy Functions — Design Assist Handy Functions — Quick Exchange

Click  (Design Assist Area Set Mode) on the 
tool bar.

1
Drag an area where you want 
to adjust the layout.2

Click Generate 
Design displayed.
This displays a variety of 
designs that are laid out in 
the specified area.

3

Select a desired 
design.4

Click OK.
The selected poster is displayed.

5

Click  (Quick Exchange) on the tool bar.1
Click on objects you want 
to move.2

Drag the selected 
objects over the 
position of the 
objects you want 
to switch.
The objects are switched.

3

Check that the objects 
has been exchanged in 
the position you want 
and release the mouse 
button.

4

Repeat steps 1 through 4 
until the design is complete.

The design assist function allows you to automatically layout a 
specified area and to create multiple design choices. There is a 
wide variety of poster designs, from which you can select one that 
fits your needs and wants.

The quick exchange function allows you to switch the positions 
of multiple objects by simply using your mouse. This function is 
useful for editing designs and making corrections to completed 
designs because you can easily create modified designs.
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Click  .
When the poster is in landscape orientation, click  at the bottom of 
the screen.

1
Click the Cloud sharing menu.1

Select the menu that corresponds to your 
application.2

Handy Functions — Temporary tray Handy Functions — Cloud Sharing

Temporary 
tray status will 
be included in 
the file when 
the poster is 
saved. However, 
templates will be 
deleted.

Temporary 
tray

To place objects in temporary tray, drag and drop an 
object in the library (list) to temporary tray.2

To add an object in temporary tray to 
the poster, double-click the object.
Alternatively, drag and drop the object to the poster.

3

In temporary tray, place templates, photos, clipart, etc. 
temporarily.

You can share poster files, etc. with other computers and 
users in order to utilize them more effectively by uploading 
and downloading the files via cloud storage.

Download poster/material
Allows you to download poster files and image files that have been saved in 
cloud storage.

Upload currently open poster
Allows you to upload the currently open poster file to cloud storage.

Upload export file
Allows you to export artwork and upload it to cloud storage.

Tip

•  imagePROGRAF Direct Print & Share v.2.0.0 or later needs to be installed in 
order to use this function.

•  You need to have created an account with a cloud service in advance before 
using the cloud service.
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● If the Printing dialog box is displayed
1) Click Cancel.

● If there are other print jobs
1) Click Stop to open the Cancel 

copy job dialog box.
 In the Cancel copy job dialog 

box, only the print jobs performed from 
PosterArtist QuickCopy are displayed.

2) Select the job and click Cancel.

● If the Status Monitor is displayed
 In the Status Monitor, all print jobs are displayed.
1) Select the job and click Cancel Job.

        Auto crop

Click this to specify the 
scanning area automatically.

Connect a scanner and double-click 
the PosterArtist QuickCopy icon on the 
desktop.

1

Tip Canceling Printing
Cancel printing in either of the following ways.

Producing Enlarged Copies

Only the area within 
the dashed lines is 
scanned. To adjust the 
scanning area, drag 
the frame.

Place the original in the scanner.2
Specify the paper and number of copies.
In Copy Size, select the size of the enlarged copy.
The scanned original is enlarged to the specified size then printed.

3

Click Preview.
The image is displayed, with the scanning area indicated by dashed lines.

4

Click Copy.
The original is scanned and printing starts.

5

Tip Detailed settings
In Detailed settings, specify settings for 
the scanner and printer in detail. Also, 
specify the image quality for scanning.

        Reset crop

Restores the default scanning 
area.

To place scanned 
images on the poster, 
click Edit with 
PosterArtist.

PosterArtist QuickCopy allows you to produce enlarged 
copies of the original in the scanner simply by clicking a 
button, as if making copies on a copier.

● Moire reduction
Moire is image distortion (uneven, lighter 
areas or striped patterns) that may occur 
when scanning photos or pictures. 
Place a checkmark for this to lessen this 
distortion. 

● Edge enhancement
Enhances the outline with sharpness 
increased.

● Set-off reduction
When the original is double-sided, 
images or text on the reverse side 
may be scanned. Place a checkmark 
for this to reduce such effect.

● Background color removal
When paper of the original is lightly 
colored with yellow, etc., place a 
checkmark for this to correct the base 
color and make it white.
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